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1.0 Introduction

1.1 Intended Audience

This document is intended to help Local Education Agencies (LEAs) quickly become familiar with and use the Principal Apportionment software. Understanding basic Windows functions and procedures, such as clicking, double clicking, right clicking, browsing, etc., will assist you in using this document and software.

1.2 Document Conventions

This document uses the following conventions to describe functions and procedures in the software:

	Window Names
	The names of windows, screens, and dialogue boxes use title case, such as:
Save As window
User Information screen

	Commands
	Commands are operations you must follow in order to perform certain functions in the software. Bold face font is used, such as:
Select Print from the File menu
Click the OK button

	Image Names
	Images, or pictures, are described as Figures and use Italic face font, such as:
Figure 1:  Diagram of the data process.

	Important Notes
	Notes include important statements regarding steps you may need to take. They are highlighted in gray, with a black border on the top and bottom, such as:

Note: Important note here


1.3 Related Documents

For step-by-step installation instructions, please refer to the Principal Apportionment Attendance, Revenue, and Tax Software Installation Guide that accompanies this User Guide.

For more information on using the software, please refer to the Help file in the Principal Apportionment Revenue Software, the Principal Apportionment Attendance Software, or the Principal Apportionment Tax Software.

System Requirements

The installation of the software requires approximately 60 MB of hard disk space. Before you install the software, make sure your computer meets the following minimum hardware requirements:

	Minimum Hardware Configuration

	· Intel Pentium III based PC

· 733 MHz processor speed

· Windows NT

· 128 MB RAM

· 1.2 GB free hard disk space

· 2 MB graphics card

· Color Monitor capable of 1024 × 768 pixel resolution


To receive optimal performance from the software, you should have at least the following recommended configuration:

	Recommended Hardware Configuration

	· Intel Pentium 4 based PC

· 1.8 GHz processor speed

· Windows 2000

· 256 MB RAM

· 4 GB free hard disk space

· 48x speed CD-ROM Drive

· 17″ Color Monitor

· High-speed Internet connection


For optimal performance, it is best to have a computer equipped with a CD-ROM drive and/or high-speed Internet service available for obtaining and installing the software. Having a typical dial-up connection can take up to 10 hours to download the software. With a high-speed Internet connection, the download time is approximately 5 minutes.

2.0 Installing the Principal Apportionment Software

This chapter gives an overview of the tasks that must be completed in order to properly install the software. For specific installation instructions, please refer to the Principal Apportionment Attendance, Revenue, and Tax Software Installation Guide.
2.1 Installation Procedures

Installing the software from the Internet.

1. Download the software from the Internet at http://www.cde.ca.gov/fg/sf/ to your desktop. You can download the software from either Internet Explorer or Netscape Navigator. Select the appropriate file (for Attendance, Tax, or Revenue software, respectively).

2. Find and double-click the software executable file downloaded from the Internet.

3. The InstallShield Wizard window displays.

4. The Preparing to install window displays.

5. The Welcome window displays.

6. Click Next. The Customer Information window displays. Enter your information.

7. Click Next. The Ready to Install the Program window displays.

8. Click Install. The progress meter displays the installation status.

9. When the installation is complete, the Installation Completed window displays, and the dialog box shows whether or not the software installed successfully.

10. Click Finish.

Note:
You may be asked to restart your computer. Click Yes. After the computer restarts, you can start using the Software.

2.2 Version Checking

Version checking is an important method used to ensure the correct version of the software is being used. When you open the software, the Logon screen displays the version number (Figure 1). Check the version number on the CDE Web site at http://www.cde.ca.gov/fg/sf.
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Figure 1: Sample Version Number On The Logon Screen

3.0 Basic Operating Procedures

3.1 Adding a New User

You can add one or more users to the system. Add a user by clicking the New User button in the Logon screen. After you click the New User button, the New User screen displays (Figure 2).
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Figure 2: New User Screen

Some fields are not active until after you select other fields. For example, the County field is not active until you select a user group from the User Group field. You must enter data in the required fields to save the record. These required fields are noted in Table 1.

	Field
	Description
	Notes

	Contact Name
	Your user login name. 
	Required field.

	User Group
	Select the user group from the drop-down list. 
	Required field.

	County
	Select the county from the drop-down list. 
	Required field.

	School District
	Select the school district from the drop-down list. 
	Required field. 

This field is disabled for county office and county auditor user groups.

The field changes to SELPA AU for the SELPA user group.

	SELPA AU
	Select the SELPA Administrative Unit from the drop-down list.
	Required field.

This field only displays for a SELPA user group.

	School
	Select the school from the drop-down list.
	Required field for the charter school user group. This field is only active for a charter school user group.

	Phone
	Your telephone number. 
	Required field.

	Fax
	Your fax number.
	Optional field.

	E-Mail
	Your e-mail address.
	Optional field.


Table 1: New User Screen Fields

After you enter your information, click OK. If you did not enter data in a required field, a dialog box displays alerting you to the missing data. If you want to close the New User screen without saving the data you entered, click Cancel.

Once you click OK the Logon screen displays again with the new user you entered in the Please Select User dialog box.

3.2 Logging On

To log on and begin using the software after you have added a new user:

1. Select the user from the Please Select User drop-down list in the Logon screen.

2. Click the Logon button. The Main menu screen displays (Figure 3).
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Figure 3: Main Menu

3.3 Getting The Latest LEA Updates

You can update LEA information (i.e., grade levels, new districts, or new schools) in the software database with a CDE-supplied text data file by clicking the Get Latest button in the Logon screen. The CDE will supply this file upon request. After you click the Get Latest button, the Importing Data for Get Latest screen displays (Figure 4).
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Figure 4: Importing Data For Get Latest Screen

To get the updates:

1. Click Select File.

Note:
You can close the window without importing any data by leaving the field blank and clicking the Close button.

2. Select the text file in the Open window. 
3. Click Open.
The Open window closes and the file name and location displays in the text box in the Importing Data for Get Latest screen. The import process begins. A message box displays when complete. Click OK to view the Status Report. If you try to import a file with an invalid format, the Status window displays an error message. You can save, print, or close the Status window. 
4. Click Close.

Accessing Online Help

This section provides information on accessing the Online Help.

Clicking Help or pressing the F1 key from the Main menu displays the Help window shown in Figure 5. Some areas of help include assistance for screens, deadline information, and general software help. Clicking Help or pressing the F1 key from an entry screen displays the Help window for that entry screen.
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Figure 5: Online Help Window

3.4 Navigating Main Menus

The Main menu is the starting point for entering data into the software.

The User Group selected when your account was created determines the Main menu screen appearance.

3.4.1 Main Menu Grids

There are two grids on every Main menu:

· LEA grid

· Entry Screens grid

The LEA grid displays information about the LEA(s). The columns are described in Table 2.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is “No.” Change the selection to “Yes” by clicking the SELECTED cell in the appropriate LEA row.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	LOWEST GRADE
	The lowest grade level offered for the LEA; 0 is displayed for kindergarten. N/A for SELPA LEA.

	HIGHEST GRADE
	The highest grade level offered for the LEA. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


Table 2: LEA Grid Information

The Entry Screens grid displays a list of entry screens that you can access to enter or view data. Each row contains information about entry screen data. The columns are described in Table 3.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is “No.” Change the selection to “Yes” by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time records in the entry screen were last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Not all screens are checked for errors, but the field still contains date and time information upon saving (for example, Handicapped ROC/P).

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


Table 3: Entry Screens Grid Information

3.4.2 Main Menu Commands

3.4.2.1 File Menu

The File menu contains the following commands shown in Table 4.

	Command
	Description

	Import
	The Import sub-menu allows you to import either ASCII (text) files or certified data files.

	Export
	The Export sub-menu allows you to export data to an ASCII (text) file or to a certified data file. 

	Print
	The Print sub-menu allows you to print various types of reports, depending on the software application you use and the user group selected. Please refer to Table 12 for more information.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports and the default number of copies you will print each time.

	Logout
	The Logout command logs the current user out of the application and returns to the Logon screen.

	Exit
	The Exit command closes the program and returns you to Windows.


Table 4: File Menu Commands

3.4.2.2 Period Menu

The Period menu allows you to switch between different reporting periods for the current fiscal year and for corrections. 

There are three reporting periods for the current fiscal year (P-1, P-2, and Annual) and two reporting periods for corrections (P-2 and Annual). When you open the software for the first time, the default reporting period selected is P-1. Each time you reopen the software after that, it will always open to the last reporting period used.

Note:
A checkmark displays next to the selected period in the Period menu.

When reporting data for the current fiscal year, select a period by selecting P-1, P-2, or Annual from the Period menu. When reporting data for corrections, select Corrected from the Period menu, then select P-2 or Annual from the sub-menu.

The list of entry screens available may change for the specific period.

3.4.2.3 LEA Menu

The User Group selected when the account was created determines the LEA menu choices. The LEA menu displays differently for county LEAs, school district LEAs, charter school LEAs, county auditors, and SELPAs.

Note:
The software automatically displays the LEA menu based on the User Group. 

3.4.2.4 Tools Menu

The options available in the Tools menu depend on the software being used and the user group selected. Table 5 displays a summary of the commands available by software:

	Command
	Software:
	Description

	
	Attendance
	Tax
	Revenue
	

	User Information
	(
	(
	(
	The User Information screen displays your current user information and allows for modification to the contact name, telephone number, fax number, and e-mail fields 

	Contact Information
	(
	
	(
	The Contact Information screen displays user information for lower-level LEAs. For example, Alameda county can access the user information for school districts and charter schools within the county, provided they have imported data from them.

	Necessary Small School Certification Selection
	
	
	(
	County Offices of Education are required to certify the selection of schools for the application of the Necessary Small School Funding Model in accordance with Education Code Sections 46200 and 46201.

	Calculate Revenue Limit
	
	
	(
	Depending on the user group type, allows the user to calculate Revenue Limit amounts at the county, district, or charter school level.

Note: Charter School calculations have been disabled.

	Calculate SELPA
	
	
	(
	Depending on the period and user group, allows the user to calculate the AB 602 estimate, the Infant Entitlement estimate, Out of Home Care estimate, and the Extraordinary Cost Pool estimate amounts.

	Reconciliation
	
	
	(
	The reconciliation command allows users to import final apportionment data as received from CDE.

	Forecasting
	
	
	(
	The forecasting command allows users to project future apportionment amounts based on varying growth rates and parameter changes.

	Forecasting Parameters
	
	
	(
	Allows users to use state-supplied parameters, or enter new parameters to aid in projecting future apportionment amounts for future fiscal years. 

	Upload Certified Data
	
	
	(
	Sends the final certified data file to the CDE.


Table 5: Available Tools Menu Commands

3.4.2.5 Help Menu

The Help menu is a useful tool if you need assistance with a particular entry screen or program function. For more information on utilizing online help, see Section 3.4.

Clicking About displays the version number of the software, similar to the Logon screen. To return to the Revenue software, click OK. If you would like to view your Windows system information, click System Info. The System Information window displays information about your hardware, software, and Windows environment.

3.4.3 Selecting and Opening an Entry Screen

To select and open an entry screen:

1. Select the LEA by clicking the far left column of your selected LEA row in the top grid of the Main menu screen.

2. Open the entry screen by clicking the far left column of the entry screen row in the bottom grid of the Main menu screen.

Note:
Not all entry screens are available to all LEAs.

When you open an entry screen for the first time, the screen displays and highlights the value in the first available data entry field.

Note: 
If you cannot view the entire entry screen, use the vertical and horizontal scroll bars on the right and bottom sides of the screen, respectively. If your computer has higher video resolution, you may be able to resize your window so more of the entry screen displays.

When you open an entry screen that contains existing data, the data displays in the proper fields.

The data is entered into “cells.” Some cells may be disabled (grayed out). These disabled cells are used to show calculated values or to prevent a user from entering data that does not apply to them. Figure 6 displays a sample entry screen.
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Figure 6: Sample Entry Screen

You can enter data by typing the value into that field. If you have a fractional amount, you can enter that value by pressing the PERIOD key after you enter the whole number, and then type the two digit decimal amount. For example, if the amount is 230.25, type 230, press the PERIOD key, and then type 25. If you do not have a whole number value that precedes the decimal point, such as 0.75, press the PERIOD key first and then type 75.

3.4.3.1 Moving Through Fields

You can move to a different field in two different ways. You can press the TAB key to move the cursor to the next field, or you can move the mouse pointer over the field you want and then click the left mouse button. You can move to the previous field by pressing SHIFT+TAB. The program highlights the value in that field once the cursor displays there. If the next field does not display in the window, the program scrolls up or down the entry screen to display your selected field.

3.4.3.2 Entering Negative Numbers

Use the minus ( - ) sign before or after a number to enter a loss, or negative value, in an entry field. The value will then display in parentheses on the entry screen and on the corresponding report.

3.4.4 Selecting LEAs and Entry Screens for Printing and Exporting to an ASCII (Text) File

You can choose either all or selected LEAs and entry screens for printing from the Main menu. You can choose either all or selected LEAs, but only one entry screen at a time for exporting to an ASCII (text) file from the Main menu.

To select all LEAs and entry screens for printing:

1. If only one row displays in the top grid of the Main menu, click the Selected column cell for that LEA row to change it to “Yes.” If more than one row displays in the grid, click the Select All button above the top grid. Each row in the top grid displays “Yes” in the SELECTED column.

2. Click the left arrow in the top grid. The Entry Screens grid (the lower grid in the Main menu) is now active.

3. Click the Select All button above the Entry Screens grid. Each row in the Entry Screens grid displays “Yes” in the SELECTED column. You can now print reports for all LEAs and entry screens that have data.

To select specific LEAs and entry screens for printing or exporting to an ASCII (text) file:

1. In the top grid of the Main menu, click the SELECTED column cell in each LEA row you want to print or export to an ASCII (text) file. The top grid displays “Yes” in the SELECTED column of each LEA row you click.

2. Click the cell to the left of any row in the top grid. The Entry Screens grid  (the lower grid in the Main menu) is now active.

3. Click the SELECTED column cell of each program you want to print a report for or click the SELECTED column cell of one program to export to an ASCII (text) file. The Entry Screens grid displays “Yes” in the SELECTED column of each entry screen you select. You can now print reports for the selected LEAs and entry screens which have data, or export all selected LEAs and one entry screen that has data to an ASCII (text) file.

Note:
Deselect LEAs and entry screens by clicking the Deselect All button or by clicking the SELECTED column cell(s) of any LEA or entry screen to change the cell(s) to “No.”

Entering Data

This section explains how to use entry screen commands, add and delete records in entry screens that contain multiple records, and switch between tabbed and drop-down menus.

3.4.5 Entry Screen Commands

3.4.5.1 File Menu

The File menu displays the options shown in Table 6.

	Command
	Description

	Save
	Saves the entered data.

Note: A dialog box is displayed whenever you try to close an entry screen without saving the data. If you click No in the dialog box, the program discards the data and you cannot retrieve it. If you click Yes, the program saves the data and that data displays the next time you open the entry screen.

	Check/Save
	Runs a series of validations to determine if the saved data passes the edit check process. If there are errors, an edit check report displays (for more information about edit check reports, see Section 4.0).

Note: Not all entry screens have the Check/Save option enabled.

	Print
	The Print sub-menu allows you to print a report based on the data saved in the entry screen. After selecting Print, a print preview is displayed. From the print preview screen, you can print or export the report.

The report will print using the default printer installed in your Windows application. All reports print on standard 8.5" x 11" paper. Each report displays the date and time of printing.

	Printer Setup
	Opens a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.

	Close
	Closes the entry screen and returns you to the Main menu.


Table 6: File Menu Commands

3.4.5.2 Note Menu

Selecting Add Note from the Note menu opens a window for creating and saving Notes to entry screens. Figure 7 displays a sample Notes window. Enter any relevant information in the text box provided and click Save. A prompt appears if you attempt to close the window without saving any notes.
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Figure 7: Sample Notes Window

3.4.5.3 Tools Menu

The Tools menu displays additional entry screen functions. For example, in the Tax software, a county auditor can use the Copy P-1 to P-2 option of the Taxes entry screen’s Tools menu to copy P-1 tax data to P-2.

Note:
The Tools menu is only available in the Taxes entry screen and the Special Education Tax Allocation entry screen.

3.4.5.4 Help Menu

The Help menu functions in the same manner as on the Main menu screen. Please refer to Section 3.4 for more information on utilizing online help.

3.4.6 Entering Data into Single Record Entry Screens

Some entry screens only allow one record to be created for the selected LEA (Figure 8).
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Figure 8: Sample Single Record Entry Screen

In single record entry screens, the Save, Check/Save, Delete, Cancel, and Close buttons are displayed.

Note:
The Check/Save button is not available in all entry screens.

3.4.7 Entering Data into Multiple Record Entry Screens

Some entry screens allow multiple records to be created (Figure 9).
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Figure 9: Sample Multiple Record Entry Screen

Select an existing record, add a new record, or delete the currently selected record by clicking on one of the following buttons as shown in Table 7.

	Button
	Description
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	Moves to the first record.
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	Moves to the previous record.
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	Moves to the next record.
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	Moves to the last record.
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	Adds a new record.
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	Deletes the currently selected record.


Table 7: Multiple Record Entry Screens Navigation Buttons

3.4.7.1 Adding Records

To add a record to the screen:

1. Click on the Add New button. The Add New Record screen displays, similar to the one shown in Figure 10.
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Figure 10: Sample Add New Record Screen

2. Choose the LEA you want to enter data for, and then click on the Add Record button. You can now enter data for that LEA. Figure 11 shows an entry screen after completing the Add New record entry screen.
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Figure 11: Sample Entry Screen After Adding A New Record

3. Click Save to save the record. 

4. Add additional records by following steps 1-3.

3.4.7.2 Deleting Records

To delete a record:

1. Select the record you want to delete.

2. Click on the Delete button.

3. Click Yes in the Delete dialog box.

3.4.7.3 Selecting and Searching for Records

If you want to open a saved record in the entry screen, you can select an existing record by using the buttons described in Table 7. 

Some entry screens have an additional search feature ([image: image19.png]


). For example, you can search for records in the Class Size Penalties entry screen which have a specific average class enrollment size by following these steps:

1. Enter the average class enrollment size you want to search for into the text box at the lower-left corner of the entry screen.

2. Click the [image: image20.png]


 button. The first record with the enrollment size you entered in the text box displays in the entry screen. You can search for the next record that contains the enrollment size (for Less Than Full Second Period selection) by clicking the [image: image21.png]


 button again.

A dialog box displays when you reach the last record or if the record was not found.

3.4.8 Switching Between Tabbed and Drop-Down Menus

Each entry screen contains one or more tabs. These tabs display in a row at the top of the screen (Figure 12).
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Figure 12: Entry Screen Tabs

If an entry screen has more than one tab, you can move to each entry screen by clicking on the tab. After you click the tab the screen displays.

At the end of the tab row the Drop-Down menu button ([image: image23.png]


) displays. When you click this button the tab menu changes to a drop-down text box showing the name of the currently selected tab with a drop-down arrow on the right. The Drop-Down menu button changes to the Tabs button (Figure 13).
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Figure 13: Entry Screen Drop-Down Menu

You can view each tab by clicking on the drop-down arrow and then selecting a screen from the drop-down list. You can revert back to tab view by clicking on the Tabs button ([image: image25.png]


).

3.5 Resizing Windows

You can resize a window by moving your mouse pointer to an edge or the corner edge of the window. The pointer changes into a two-sided vertical arrow when the pointer is moved over the top or bottom edge, a two-sided horizontal arrow when the pointer is moved over the left or right edge, or a two-sided diagonal arrow when the pointer is moved over a corner edge. Then you can hold down your left mouse button and move the mouse to shrink or enlarge the window size.

4.0 Edit Check Reports

After data is entered, users should run a validation process on their data. This section describes how to perform the edit checks.

Note: Not all entry screens have the Check/Save option enabled.

To check your data for errors:

1. Enter data into the entry screen.

2. Click the Check/Save option or button, if available. The program saves your data and checks it to ensure that no errors exist. If no errors exist, a dialog box displays to inform you that the data have passed the error check process (Figure 14).
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Figure 14: Edit Check Process Message Box

If an error does exist, an Edit Check report displays the error as shown in Figure 15.
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Figure 15: Sample Edit Check Report

The Edit Check Report displays a table listing fields that contain invalid data. Table 8 describes the information in each column.

	Column
	Description

	Line No
	The line number and column (A or B) in the entry screen that contains the erroneous field.

	Field Caption
	The name of the field.

	Type
	The error severity type: E (error) or W (warning). An error with type E is a fatal error, and you will not be able to certify and export the data until you fix the problem as stated in the Message column. A type W error is a warning that reminds you about possible errors or problems in the entry screen. Warnings do not affect your ability to export the data.

	Message
	The message in this column instructs you how to rectify the error.

	Comments/Notes
	Allows the user to document comments or notes regarding the erroneous field and column for their records.


Table 8: Edit Check Report Information

The Edit Check screen contains the following functions as shown in Table 9.

	Button/Function
	Description
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	Sends the report to the printer.
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	Exports the report into an HTML or ASCII (text) file.
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	Sets the magnification level from the drop-down list.
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	Moves to the first page in the report.
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	Moves to the previous page in the report.
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	Moves to the next page in the report.
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	Moves to the last page in the report.


Table 9: Edit Check Screen Functions

3. Click OK to close the edit check passed message box, or click [image: image35.bmp] to close the Edit Check Report. 

4. Make the necessary corrections in the entry screen until there are no fatal errors.

5. Close the entry screen.

5.0 Correcting Data from a Prior Period

If you need to submit corrected data for prior P-2 or Annual reporting periods, you can input corrected data by selecting the Period menu, then selecting P-2 or Annual from the Corrected sub-menu.

If you have not yet submitted data or need to correct data and the cutoff period has recently passed, contact CDE to determine if an original (non-corrected) file may still be accepted.

Note: 
You must use the appropriate fiscal year software to make corrections. For example, you would use the 2008-09 software in fiscal year 2009-10 to make the 2008-09 corrections. Any data that is changed replaces previously saved data.

5.1 Corrected Period Main Menu

When you log in and select a corrected period from the Period menu, the Main menu displays the CORRECTED columns shown in Figure 16.
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Figure 16: Main Menu Screen For Corrected Periods

The LEA grid columns in a corrected period’s Main menu are described in Table 10.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate LEA row.

	CORRECTED
	Denotes whether corrections have been made. The default selection is No.

	COUNTY ID
	The county identification number.

	DISTRICT ID
	The district identification number.

	SCHOOL ID
	The school identification number. N/A for SELPA LEA.

	COUNTY NAME
	The county name.

	DISTRICT NAME
	The district name.

	SCHOOL NAME
	The school name, if any. N/A for SELPA LEA.

	DISTRICT TYPE
	The district type. N/A for SELPA LEA.

	LOWEST GRADE
	The lowest-grade level offered for the LEA; 0 is displayed for kindergarten. N/A for SELPA LEA.

	HIGHEST GRADE
	The highest-grade level offered for the LEA. N/A for SELPA LEA.

	SELPA NAME
	The SELPA name. For SELPA LEAs only.

	SELPA COUNTY
	The county in which the SELPA resides. For SELPA LEAs only.

	SELPA ID
	The SELPA identification number. For SELPA LEAs only.


Table 10: LEA Grid Columns For Corrected Periods

The Entry Screens grid columns for corrected periods are described in Table 11.

	Column
	Description

	SELECTED
	Denotes selection status for printing reports and/or exporting to an ASCII file. The default selection is No. Change the selection to Yes by clicking the SELECTED cell in the appropriate entry screen row.

	ENTRY SCREEN NAME
	The entry screen name.

	CORRECTED
	Denotes whether corrections have been made to the data in the entry screen. The default selection is No.

	REASON CODE
	The reason code for the correction.

	CERTIFICATE NUMBER
	A unique number that is generated after data is entered and saved.

	NUM RECORD
	Number of records in the entry screen.

	NUM ERROR
	Number of errors in the entry screen.

	NUM WARNING
	Number of warnings in the entry screen.

	LAST MODIFIED DATE
	The date and time the entry screen was last modified and saved.

	LAST EDIT CHECK DATE
	The date and time the entry screen data was last saved and checked for errors. Note: Not all entry screens have the Check/Save option enabled.

	LAST EXPORT DATE
	The date and time the entry screen data was last exported to a certified data file.

	LAST IMPORT DATE
	The date and time that certified data was last imported into the entry screen.


Table 11: Entry Screen Grid Columns For Corrected Periods

5.2 Correcting Data

To correct data after the cut-off date:

1. Select Corrected from the Period menu.

2. Select the period (P-2 or Annual) you want to correct from the Corrected submenu. The list of entry screens in the Entry Screens grid changes to reflect the screens available to correct for the selected period and LEA type.
3. Select the LEA in the top grid to activate the Entry Screens grid.

4. Open the entry screen to correct and make any necessary changes to the data.

Note:
Data entered in the standard P-2 or Annual reporting periods will be displayed in the entry screen fields.

5. Click Save or Check/Save.

Note:
Remember to click Check/Save (if available) to ensure the entered data passes the edit check process.

6. Click Close to close the entry screen.

7. Upon closing the entry screen, the Correction Reason dialog box displays as shown in Figure 17.

Note:
The Correction Reason screen will not display unless data (original or corrected) has been saved in the entry screen.
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Figure 17: Correction Reason Screen

8. Select the reason for the correction from the Correction Reason drop-down list.

9. Type correction notes in the Correction Notes text box.

Note:
You must enter notes in this text box. Do not leave the text box blank.

10. Click Close. The Correction Reason screen closes and the Main menu displays.

Note:
In the Entry Screens grid, the CORRECTED column displays “Yes” and the correction reason selected is displayed in the REASON CODE column. In the top grid, the CORRECTED column for the LEA row that was corrected displays “Yes.”

Once the CORRECTED column displays “Yes,” you can re-enter the Correction Reason dialog box by clicking the “Yes” in the CORRECTED column cell in the Entry Screens grid.

Saving Data in P-2 and Annual Reporting Periods

Any data that is changed and saved replaces previously saved data. If you change and save P-2 or Annual corrected period data, the data changes OVERWRITE the previously saved P-2 or Annual period data. Conversely, if you change and save P-2 or Annual data in the “standard” (meaning from the Period menu, not from the Period menu’s Corrected sub-menu) reporting period, the saved changes overwrite any existing P-2 or Annual corrected period data.

For instance, suppose you saved P-2 data in the standard reporting Period menu. After submitting the data, you want to change (correct) the data and resend it. You select P-2 from the Period menu’s Corrected sub-menu and enter data for the same LEA. In this case, if you save the corrected data, it will replace the P-2 data you originally entered in the standard P-2 period.

6.0 Importing and Exporting

Once data is entered, it can be exported to a file and/or imported to another program. This section describes how to import and export data files and send those files to the CDE.
6.1 Importing Data Files

6.1.1 Importing ASCII Files

You can import data into the program from a properly formatted ASCII (text) file. When opened in Notepad, a properly formatted ASCII file displays each entry screen’s table name (as used in the software) and entry field names on one line. Beneath this line, an additional line exists for each record in the entry screen. These additional lines display the entry screen’s table name, and the actual data in each entry field. Data must be in proper sequence and format to be imported. 

To import an ASCII (text) file from the Main menu screen:

1. Click Import from the File menu.

2. Click ASCII File in the submenu. The Importing ASCII Data screen displays (Figure 18).
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Figure 18: Importing ASCII Data Screen

3. Click Select File and select the file you want to import.

4. Click Open.

After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing ASCII Data screen without importing any data by leaving the field blank and clicking Close.

Note:
If the program cannot import the file, a dialog box displays and informs you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data.

Importing Certified Data Files

You can import a certified data file into the program.

To import a certified data file from the Main menu screen:

1. Click Import from the File menu.

2. Click Certified Data in the submenu. The Importing Certified Data screen displays (Figure 19).
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Figure 19: Importing Certified Data Screen

3. In the Importing Certified Data screen, click Select File.

4. Select the file you want to import.

5. Click Open.

After the program imports the file, the Status window displays the results of the import process showing the number of records skipped, copied, and overwritten. You can save, print, or close the Status window. You can close the Importing Certified Data window without importing any data by leaving the field blank and clicking Close.

Note:
If the program cannot import the file, a dialog box displays and informs you. If data already exists in the record you are importing data into, one or more dialog boxes display that ask if you want to overwrite the data.

Exporting Data Files

6.1.2 Selecting Data to Export

You can export entry screen data to an ASCII (text) file or a certified data file, but first you must select data to export. The process for selecting data depends on whether you want to export an ASCII (text) file or certified data file.

6.1.2.1 Selecting LEAs and Entry Screens for Exporting to an ASCII (Text) File

For more information on selecting data to export to ASCII (text) files, please see section 3.5.4.

6.1.2.2 Selecting LEAs and Entry Screens for Exporting to a Certified Data File

Access the Export Certified window by selecting Export from the File menu, then selecting Certified Data from the sub-menu.

You can select all LEAs and entry screens, or individual LEAs and entry screens for data export to a certified data file by using the Export Certified window (Figure 20).
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Figure 20: Export Certified Window

Note:
The Export Certified window will display differently depending on your user group type.

The Export Certified window displays two panes. The left pane displays a tree view of all LEAs, and the right pane displays a tree view of all available entry screens. 

Selecting checkboxes in each pane automatically selects each branch of the tree. For example, selecting the District(s) checkbox in the left pane automatically selects each school district in the county (Figure 21).
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Figure 21: Export Certified Window With All Districts Selected

Click the “+” sign to view all items in each LEA or program. Click the “-” sign to hide the items.

To select all county, district, and charter school LEAs for export, select the checkbox to the left of LEA(s) (at the top of the left pane). To select all county, district, and charter programs for export, select the checkbox to the left of Program(s) (at the top of the right pane). SELPA LEAs and programs must be selected separately.

To select individual LEAs and entry screens, navigate through the left and right panes and select the checkbox beside each LEA and entry screen you want to export. 

6.1.3 Exporting ASCII Files

You can export data to an ASCII (text) file for internal distribution.

To export entry screen data into an ASCII file:

1. Select the LEA(s) and entry screen you want to export (see Section 3.5.4).

2. Click Export from the File menu.

3. Click ASCII File in the submenu. The Save As window displays.

4. Navigate to a folder and enter the file name in the File name field or accept the default folder and file name.

5. Click Save. The Status window displays.

6. Save, print, or close the Status window.

6.1.4 Exporting Certified Data Files

You must export the data you entered in the program to a certified data file to send to the CDE by the filing dates. You can export Selected Certified Data or All Certified Data.

6.1.4.1 Exporting Selected Certified Data

To export Selected Certified Data:

1. Click Export from the File menu.

2. Click Certified Data in the submenu. The Export Certified window displays.

3. Navigate through the Export Certified window and select the checkbox beside each LEA and entry screen you want to export. When making selections, appropriate combinations of LEAs and Programs must be selected. For example, if only the Charter School(s) box is selected in the left pane, and a County Offices of Education Program is selected in the right pane, an error message will display. (For more information on selecting LEAs and programs, see Section 6.2.1.2).

4. Click Export. The Data Modification window displays.

5. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see Section 6.2.3.3). 
6. Click OK. The Status window displays. 
7. Note: You can save, print, or close the Status window.

8. Close the Status window.

9. Close the Export Certified window by clicking the Cancel button.

Note:
If you get an error in your Export Status window, check the Entry Screens grid to ensure that the date and time in the LAST EDIT CHECK DATE column is the same or later than the date and time in the LAST MODIFIED DATE column. The entry in the LAST MODIFIED DATE column only indicates when you last saved the data, not the last time you checked the data for errors.

10. In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.

Exporting All Certified Data

To export All Certified Data:

1. Click Export from the File menu.

2. Click Certified Data in the submenu. The Export Certified window displays.

3. Select the LEA(s) checkbox in the left pane of the Export Certified window. A check mark is displayed in the check box.

4. Select the Program(s) checkbox in the right pane of the Export Certified window. A check mark is displayed in the check box.

Note:
Because there are different due dates for attendance, revenue, and tax data, you should expand the county and district trees in the right pane and only check the appropriate program box when exporting data for the CDE.

5. Click Export. The Data Modification window displays.

6. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions. (For more information on Data Modification, see Section 6.2.3.3).

7. Click OK. The Status window displays.

8. Close the Status window. 

Note:
Because a SELPA AU type logon differs from other LEAs, two export files must be completed if SELPA data is present. One file containing all county, school district, charter school and tax data must be prepared, and one containing only SELPA data must be prepared.

9. Close the Export Certified window.

Note:
If you get an error in your Export Status window, check the Entry Screens grid to ensure that the date and time in the LAST EDIT CHECK DATE column is the same or later than the date and time in the LAST MODIFIED DATE column. The entry in the LAST MODIFIED DATE column only indicates when you last saved the data, not the last time you checked the data for errors.

10. In the Entry Screens grid, the export date and time is displayed in the LAST EXPORT DATE column in the entry screen row.

Data Modification

The Data Modification window (Figure 22) must be used to explain any changes you have made to data that you are submitting. The Data Modification window is user group specific, e.g. the questions and certification language are different depending on user group type.
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Figure 22: Sample Data Modification Window

This window must be completed before the export file creation process will begin.

1. Answer the questions in the Data Modification window. You must select “Yes” for question 1 to enable the OK button. You must provide details in the text boxes immediately below questions 2 through 5 if you select “Yes” for any of those questions.

2. Click OK after answering all of the questions. The export process will commence.

3. Upon completion, a status window will display with details on the data exported.

4. You can then print a Certification Exception Report for your records. (For more information on printing a Certification Exception Report, see Section 8.2).

7.0 Submitting Certified Data Files

7.1 Sending Certified Files to County Office of Education (COE)

This section applies to school districts, charter schools, county auditors, and Special Education Local Plan Areas (SELPAs).

After you export your data to a certified data file, send the certified file to your school district or COE by e-mail or floppy disk.

For example, a charter school user will enter their data into their entry screens, export their certified data to a certified data file, and send the export file to their school district. The district will import the file(s) received from their charter school(s). The district will also enter their data into their entry screens. The district will export all the data (district and charter) to a certified data file, and send the export file to their county.

E-mail makes the submission process quick and easy; however, you must also submit your signed certification page to your district or COE. Refer to your e-mail software documentation for instructions about how to attach files to e-mail.

Your Internet Service Provider (ISP) may have attachment size limits, so ensure that e-mail attachments do not exceed the size limit. Contact your ISP for more information.

You can also copy the certified data to a floppy disk and submit it along with your signed certification page to your school district or COE.

Uploading Certified Data

This section applies to COEs.

After COEs export their file to a certified data file, COEs must send the certified file to CDE via File Transfer Protocol (FTP). The Revenue software contains an FTP component. 

Additionally, the County Superintendent must sign the Certification pages submitted from their district(s) and/or charter school(s) and keep them on file.

To upload a certified data file:

1. Select Upload Certified Data from the Tools menu. The Submit Datafile window displays (Figure 23).
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Figure 23: Submit Datafile Window

2. Enter the County Password and click Select File. The Select Datafile to Submit window displays (Figure 24).
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Figure 24: Select Datafile to Submit Window

Note:
If the password is not entered, the Please Enter Password message box displays (Figure 25).
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Figure 25: Please Enter Password Message Box

Note:
If the incorrect password is entered, the Incorrect Password message box displays (Figure 26).
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Figure 26: Incorrect Password Message Box

3. Select the file to submit and click Open. The Uploading Confirmation message box displays (Figure 27).
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Figure 27: Uploading Confirmation Message Box

4. If the correct file name is displayed in the message box, click Yes. When the upload process is complete, a Status window displays showing the results of the upload process. 

Note:
The data file name must begin with the type of software used to create the file. An example of a valid data file name would be RevenueV9_00_1_01_Nov_23_2009_10_36_30.

5. Click Close to close the Status window.

6. Click Close to close the Submit Datafile window.

7.1.1 Setting FTP Configuration

School districts, charter schools, SELPAs, or county auditors may want to use FTP to send their files to their COE. If so, they will need to set up their FTP configuration first.

To set the FTP configuration for uploading certified data files:

1. From the Submit Datafile window, click Advanced.

2. Enter the FTP Configuration field information as needed. 

	Field
	Description

	Server
	Server IP address

	Directory
	Directory where uploaded data file will be placed.

	Port
	FTP port number

	Username
	User name

	Password
	User password


3. Click OK to add the changes, or Cancel to revert to the default field data.

8.0 Printing Data

Reports can be printed from any entry screen and the Main menu using the software’s Print utility. Before you print reports, you should set up your printer.

From the File menu, select Printer Setup to open a standard Windows Printer Setup window. You can select the printer to which you will print reports, and the default number of copies you will print each time.

8.1 Printing Reports from an Entry Screen

Each individual entry screen has a report associated with it. The reports display in the Print Preview window.

Note:
The Attendance Charter School Block Grant entry screen does not display in print preview mode. It is sent directly to the printer.

To print an entry screen report:

1. Open the entry screen.

2. Select Print from the File menu. The Print Preview window opens.

Note:
To view more of the report on-screen you can resize the window, or select a zoom percentage from the Zoom drop-down list.
Click the navigation ([image: image48.png]Wl



) buttons to scroll through the pages of the report.

3. Click the Print ([image: image49.png]


) button. The Print dialog box opens.

4. Click OK. The report is sent to the printer.

5. Click the Close (() button to close the Print Preview window.

8.2 Printing Reports from the Main Menu

Before you print from the Main menu, you must select the LEA(s) and the entry screen(s) to be printed. For more information on selecting LEAs and entry screens, see Section 3.5.4. The available reports you can print depend on the software application you are using and the user group selected. Table 12 lists all software reports you can print from the Main menu for each user group.

	Available Reports
	Reports
	Blank Reports
	Certification
	Blank Certification
	COE Certification
	Summary
	Certification Exception (County, District, Charter, Auditor and SELPA)
	County Revenue Limits
	District Revenue Limits
	Charter Revenue Limits
	AB 602 Estimate 

(Available from the SELPA Sub-Menu)
	Infant Entitlement (Available from the SELPA Sub-Menu)
	Extraordinary Cost Pool (Available from the SELPA Sub-Menu in Annual only)
	Out of Home Care

(Available from the SELPA Sub-Menu)
	LEA Status Report (Attendance, Revenue, and SELPA)

	Attendance Software User Groups

	School District
	(
	(
	(
	(
	
	(
	(
	
	
	(

	Charter School
	(
	(
	(
	(
	
	(
	(
	
	
	

	Tax Software User Group

	County Auditor
	(
	(
	(
	(
	
	(
	(
	
	
	

	Revenue Software User Groups

	County Office
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(
	(

	School District
	(
	(
	(
	(
	
	(
	(
	
	(
	(
	
	(
	
	
	(

	Charter School
	(
	(
	(
	(
	
	(
	(
	
	
	(
	
	
	
	
	

	County Auditor
	(
	(
	(
	(
	
	(
	(
	
	
	
	
	
	
	
	

	SELPA
	(
	(
	(
	(
	
	(
	(
	
	
	
	(
	(
	
	(
	


Table 12: Available Software Reports For Printing (by user group)

Table 13 describes each type of printed report.

	Report Type
	Description

	Reports
	Prints data reports for selected LEA(s) (from the top grid) and entry screen(s) (from the Entry Screens grid).

	Blank Reports
	Prints a blank report that you can use as a worksheet.

	Certification
	Prints a certification page for selected LEA(s) and entry screens so you can get the proper signatures.

	Blank Certification
	A blank certification page can be printed and sent to an LEA that is not using the software to enter their data but is having their school district, COE, or other governing agency enter it for them. In these cases, the governing agency must send a blank certification page to the lower-level LEA so they may sign the certification page.

	COE Certification
	Prints a single Certification page for a selected program that lists the certification number for each LEA in the county that submitted data for that program rather than printing a separate certification page for each LEA.

	Summary
	Prints a report that includes all data that was entered in an entry screen as well as subtotals and totals for each data entry field.

	Certification Exception

(County, District, Charter, Auditor, and SELPA available from Sub-Menu depending on user group)
	Displays the questions and answers from the Data Modification dialog box that opened when you exported certified data. (For more information on Data Modification, see Section 6.2.3.3.) 

	County Revenue Limits
	County office revenue limit program reports. For more information on printing county revenue limits reports, see Section 8.2.1.

	District Revenue Limits
	School district revenue limit program reports. For more information on printing school district revenue limits reports, see Section 8.2.1.

	Charter Revenue Limits
	Charter school revenue limit program reports. For more information on printing charter school revenue limits reports, see Section 8.2.1. (NOTE: The Charter School reports have been disabled.)

	AB 602 Estimate (Available from the SELPA Sub-Menu)
	COE and SELPA AB 602 program report. For more information on printing the AB 602 report, see Section 8.2.1.

	Infant Entitlement (Available from the SELPA Sub-Menu)
	Infant Entitlement report for COEs, school districts, and SELPAs. For more information on printing the infant entitlement report, see Section 8.2.1.

	Extraordinary Cost Pool (Available from the SELPA Sub-Menu in Annual only)
	Extraordinary Cost Pool report for COEs. For more information on printing the Extraordinary Cost Pool report, see Section 8.2.1.

	Out-of-Home Care Estimate (Available from the SELPA Sub-Menu)
	Out-of-Home Care reports for either SELPA Administrative Units (COE user group only), or individual SELPA LEAs (COE and SELPA user groups). For more information on printing the Out-of-Home Care estimate reports, see Section 8.2.1.

	LEA Status Report

(Attendance, Revenue, and SELPA available from Sub-Menu depending on user group)
	Depending on the report selected, displays a report that shows the number of records for each program for which you have data, sorted by LEA.


Table 13: Principal Apportionment Software Printed Report Descriptions

After you print the reports, the Status window displays the success or failure of the printing process. You can save the status report by clicking the Save button, or print the status report by clicking the Print button. Close the Status window by clicking the Close button.

8.2.1 Printing Revenue Limit Reports

Some reports in the Revenue Software can only be generated after running what is referred to as a batch process. The batch process is a calculation process that the Revenue Software performs for the following:

· County Revenue Limits

· School District Revenue Limits

· Charter School Revenue Limits (Note: Charter School calculations have been disabled.)
· AB 602 Estimates

· Infant Entitlements

· Extraordinary Cost Pool

· Out of Home Care Estimates

You must calculate the above items using the Revenue Software before attempting to print their related reports. For information on Revenue Software calculations, refer to the Principal Apportionment Revenue Software Help File.

9.0 Attendance Software

The Principal Apportionment Attendance software is used to collect and report attendance data for school districts and charter schools. You can enter and store attendance-related data, then later certify and transmit that data to your County Office of Education (COE). 

9.1 School District Procedures

Each school district has specific procedures that should be followed to accurately report average daily attendance data in time for each Principal Apportionment period.

To report the school district’s attendance data:

1. Install the Attendance software.

2. Add a school district user and login.

3. Select the correct reporting period.

4. Enter school district attendance data in each appropriate entry screen. Some school districts do not have access to all entry screens.

5. Enter charter school attendance data in each appropriate entry screen for every charter school in the district.
or
Import a certified data file from each charter school and verify its contents.

6. Ensure that the data have no fatal errors (E) using the Check/Save utility (if available) in the appropriate entry screens.

7. Export the data for the school district and charter schools to a certified data file.

8. Send the certified data file to your COE via e-mail, FTP, or on a floppy disk through the postal service.

9. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank reports, blank certifications, summaries, or certification exceptions.

Charter School Procedures

Each charter school has specific procedures that should be followed to accurately report average daily attendance data in time for each Principal Apportionment period.

To report the charter school’s attendance data:

1. Install the Attendance software.

2. Add a charter school user and login.

3. Select the correct reporting period.

4. Enter charter school attendance data in each appropriate entry screen.

5. Ensure that the data have no fatal errors (E) using the Check/Save utility (if available) in the appropriate entry screens.

6. Export the data for the charter school to a certified data file.

7. Send the certified data file to your school district, COE, or State Board of Education Administrator (depending upon your chartering local educational agency) via e-mail, FTP, or on a floppy disk through the postal service.

8. Print and sign the certification page and send it to your school district, COE, or State Board of Education Administrator.

Optional tasks include:

1. Printing reports for each entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank reports, blank certifications, summaries, or certification exceptions.

9.2 School District Attendance Entry Screens

Table 14 displays each available school district attendance entry screen, the type of data that needs to be entered, available reporting periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	School District Attendance
	Regular ADA for pupils residing in the school district.
	(
	(
	(
	(
	(
	

	Annual Migrant ADA Increase
	Necessary Small School Annual Migrant ADA Increase
	
	
	(
	
	(
	

	School District Attendance Supplement
	Attendance and enrollment for students residing outside a district with 25% or more P.L. 874 students and Adult / ROC/P Consortium (E.C 46610).
	(
	(
	(
	(
	(
	(

	Basic Aid “Choice” Court-Ordered Voluntary Pupil Transfer
	ADA for court-ordered voluntary pupil transfers.
	(
	(
	(
	(
	(
	(

	Class Size Penalties SD
	Regular day classes and enrollments in elementary grades for each school district having more than 100 units of average daily attendance.
	
	(
	
	(
	
	(

	Necessary Small Elementary School 
	Number of full-time teachers and ADA for each necessary small elementary school. Complete prior year fields only if the school district did not submit the number of full-time teachers or ADA in the prior year.
	(
	(
	(
	(
	(
	(

	Necessary Small High School 
	Number of full-time teachers and ADA for each necessary small high school. Complete prior year fields only if the school district did not submit the number of full-time teachers or ADA in the prior year.
	(
	(
	(
	(
	(
	(

	Adults in Correctional Facilities (AICF)
	Verification of LEA’s participation in the AICF program.
	(
	(
	(
	(
	(
	

	Gifted and Talented Education
	Verification of participation in the GATE program.
	(
	(
	(
	
	(
	

	Small ROC/P-Small High School ROC/P ADA
	ROC/P average daily attendance and Small High School Service Allocation.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(

	Handicapped ROC/P
	Attendance and expenditures for handicapped pupils attending a Regional Occupational Center or Program.
	(
	(
	(
	
	(
	

	Supplemental Instructional Hours
	Supplemental instructional hours for pupils residing in the school district.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	


Table 14: School District Attendance Entry Screens

9.3 Charter School Attendance Entry Screens

Table 15 displays each attendance entry screen available to school districts and charter schools, the type of data that needs to be entered, the periods the entry screen is available for entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Attendance Charter School Block Grant EHS
	Attendance and days of operation for a charter school whose sponsoring district is an elementary or high school district.
	(
	(
	(
	(
	(
	

	Attendance Charter School Block Grant Unified
	Resident and non-resident attendance, and days of operation for a charter school whose sponsoring district is a unified district.
	(
	(
	(
	(
	(
	(

	Attendance Charter School Block Grant SBC
	Attendance and days of operation for a charter school who is funded through the block grant.
	(
	(
	(
	(
	(
	

	Attendance Charter School – Revenue Limit
	Resident and non-resident attendance, and days of operation for a charter school who is funded through the revenue limit. 
	(
	(
	(
	(
	(
	

	Basic Aid Supplement Charter School
	Attendance for a charter school funded through a basic aid supplement.
	(
	(
	(
	(
	(
	(

	Economic Impact Aid Pupil Data
	Number of economically disadvantaged pupils, number of pupils identified as English Learners, and pupil enrollment counts.
	(
	(
	
	
	
	

	Supplemental Instructional Hours
	Supplemental instructional hours for pupils attending a charter school.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	


Table 15: Charter School Attendance Entry Screens

10.0 Tax Software

The Principal Apportionment Tax software is used by county auditors to enter county and school district tax data.

10.1 County Auditor Procedures

Each county auditor has specific procedures that should be followed to accurately report taxes in time for each Principal Apportionment period.

To report the taxes for the county and all school districts:

1. Install the Tax software.

2. Add a county auditor user and login.

3. Select the correct reporting period.

4. Enter school district and county tax data in each appropriate entry screen by selecting the Tax Type (County or District) from the drop-down box.

5. Export the data to a certified data file.

6. Send the certified data file to your COE via e-mail, FTP, or on a floppy disk through the postal service.

7. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for the entry screen.

2. Exporting data to an ASCII file for use in other software.

3. Printing blank reports, blank certifications, summaries, or certification exceptions.

10.1.1 County Auditor Taxes Entry Screen

The following table displays the entry screen available to users from the county auditor user group.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Taxes
	School district and county taxes.
	(
	(
	(
	
	(
	(


Table 16: County Auditor Taxes Entry Screens

11.0 Revenue Software

The Principal Apportionment Revenue software is used by COEs, school districts, charter schools, and SELPAs to:

· Aggregate attendance data from school districts and charter schools

· Enter attendance data for county schools and programs

· Enter school district and county revenue and tax data

· Enter Special Education Infant Funding and Extraordinary Cost Pool Claim (Annual only) data

· Calculate funding estimations

· Reconcile values with CDE after final apportionment

· Use state-supplied parameters or modified state parameters to aid in budgeting for future fiscal years (Forecasting mode)

Note: 
Users can perform all functions that are available in the Attendance software and Tax software in addition to functions specific to county office, school district, and SELPA revenues. 

11.1 COE Procedures

Each COE has specific procedures that should be followed to accurately report attendance, tax, and revenue data in time for each Principal Apportionment period.

To report the attendance, tax, and revenue data for all school districts, charter schools, SELPAs, and county operated schools:

1. Install the Revenue software.

2. Add a county office user and login.

3. Select the correct reporting period.

4. Enter COE attendance, tax, and revenue data in each appropriate entry screen.

5. Enter school district attendance and revenue data in each appropriate entry screen for every school district in the county.

or

Import certified school district files and verify their contents.

6. Enter charter school attendance data in each appropriate entry screen for every charter school in the county.

or

Import certified charter school files and verify their contents.

7. Enter school district and county tax data in each appropriate entry screen.

or

Import a certified tax file and verify its contents.

8. Enter SELPA Infant Funding, and Extraordinary Cost Pool Claim data in each appropriate entry screen for each SELPA.

or

Import certified SELPA files and verify their contents.

9. Ensure that all data exists for lower-level LEAs by running a Status report.

10. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens.

11. Export the data for the COE, county auditor, school districts, charter schools, and SELPAs to a certified data file.

12. Upload the certified data files to the CDE utilizing the Upload Certified Data functionality.

13. Print and sign a COE certification and retain it for your records.

Optional tasks include:

1. Printing reports for each entry screen.

2. Printing county, district, and charter revenue limit reports.

3. Printing SELPA reports for AB 602, Infant, Out of Home Care, and Extraordinary Cost Pool programs.

4. Exporting data to an ASCII file for use in other software.

5. Printing blank reports, blank certifications, summaries, or certification exception.

6. Select a funding model for necessary small elementary and high schools.

7. Calculate charter school, school district, and county revenue limit estimates. (Note: Charter School calculations have been disabled.)
8. Calculate SELPA estimates for AB 602, Infant, Out of Home Care, and Extraordinary Cost Pool programs.

9. Reconcile existing database with database file supplied by CDE (Reconciliation mode).

10. Use state-supplied parameters or modified state parameters to aid in budgeting for future fiscal years (Forecasting mode).

11.1.1 County Attendance Entry Screens

Table 17 displays each county attendance entry screen available to COEs, the type of data that needs to be entered, available periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Attendance COE
	Elementary and high school, ROC/P, CalWORKS, and Adult average daily attendance for county schools.
	(
	(
	(
	(
	(
	

	Attendance County Operated Programs COE
	Average daily attendance for County Operated Community Schools and Special Education Day Classes.
	(
	(
	(
	(
	(
	(

	Adults in Correctional Facilities (AICF)
	Verification of LEA’s participation in the AICF program.
	(
	(
	(
	(
	(
	

	Gifted and Talented Education
	Verification of participation in the GATE program.
	(
	(
	(
	
	(
	

	Small ROC/P-Small High School ROC/P ADA
	ROC/P average daily attendance and Small High School Service Allocation.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(

	Handicapped ROC/P
	Average daily attendance and expenditures for physically handicapped pupils who are attending a Regional Occupational Center/Program but are not enrolled in a regular high school program.
	(
	(
	(
	
	(
	

	SELPA ADA Allocation
	Allocation of SELPA ADA. By allocating the ADA in this entry screen, COEs can credit the ADA to SELPAs where Special Education services were provided.
	(
	(
	(
	(
	(
	(

	Supplemental Instructional Hours
	Supplemental instructional hours for pupils attending a county operated school.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	


Table 17: County Attendance Entry Screens

11.1.2 County Charter School Attendance Entry Screens

Table 18 displays each county charter school attendance entry screen available to COEs, the type of data that needs to be entered, available periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Attendance County Operated Charter Schools Program COE
	Regular elementary and high school average daily attendance for a county-operated charter school.
	(
	(
	(
	
	(
	

	Attendance Charter School Block Grant COE
	Regular elementary and high school average daily attendance and days of operation for a county-operated charter school funded through the block grant.
	(
	(
	(
	(
	(
	

	Attendance COE Charter School-Revenue Limit
	Regular elementary and high school average daily attendance funded through the revenue limit.
	(
	(
	(
	(
	(
	

	Basic Aid Supplement Charter School
	Attendance for a county-operated charter school funded through basic aid supplement.
	(
	(
	(
	(
	(
	(

	Economic Impact Aid Pupil Data
	Number of economically disadvantaged pupils, number of pupils identified as English Learners, and pupil enrollment counts.
	(
	(
	
	
	
	

	Supplemental Instructional Hours
	Supplemental instructional hours for pupils attending a county-operated charter school.
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	


Table 18: County Charter School Attendance Entry Screens

11.1.3 County Revenue Limit Entry Screens

Table 19 displays each county revenue limit entry screen available to COEs, the type of data that needs to be entered, available periods for data entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	County Revenue Limit Adjustments
	Additional Funding, Revenues, and Expenditures data for county schools.
	(
	(
	(
	(
	(
	

	Cross County Base Revenue Limit Adjustments
	Cross county base revenue limit adjustments for Special Education, NPS/LCI, and county community schools
	(
	(
	(
	(
	(
	(

	Regional Occupational Centers and Programs (ROC/P)
	Allocated average daily attendance for a school district’s Regional Occupational Center/Program
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(

	Small Regional Occupational Centers and Programs (ROC/P)
	Allocated average daily attendance for a Small High School’s Regional Occupational Center/Program
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(


Table 19: County Revenue Limit Entry Screens

11.1.4 Tax Entry Screens

Table 20 displays the Tax entry screens available to users for the county office user group. 

Note:
County Superintendents must submit Miscellaneous Funds information, even if the amount is zero.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Special Education Tax Allocation
	Allocate percentage of tax receipts to each SELPA Administrative Unit to which the COE belongs in this screen tab.
	(
	(
	(
	
	(
	(

	Taxes
	School district and county taxes.
	(
	(
	(
	
	(
	(

	Miscellaneous Funds
	Funds from royalties, bonuses, and payments in lieu of taxes.
	
	
	(
	
	(
	(


Table 20: Tax Entry Screens

11.2 School District Procedures

Each school district has specific procedures that should be followed to accurately report attendance and revenue data in time for each Principal Apportionment period.

To report the school district’s attendance and revenue data:

1. Install the Revenue software.

2. Add a school district user and login.

3. Select the correct reporting period.

4. Enter school district attendance and revenue data in each appropriate entry screen for the appropriate district.

or

Import a certified school district file and verify its contents.

5. Enter charter school attendance data in each appropriate entry screen for the appropriate charter.

or

Import a certified charter school file and verify its contents.

6. Enter SELPA Infant Funding, and Extraordinary Cost Pool data in each appropriate entry screen.

or

Import a certified SELPA file and verify its contents.

7. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens.

8. Export the data for the school district, charter schools, and SELPAs to a certified data file and send the file to your COE.

9. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Printing district and charter revenue limit reports.

3. Printing infant entitlement reports.

4. Exporting data to an ASCII file for use in other software.

5. Printing blank reports, blank certifications, summaries, or certification exceptions.

6. Select a funding model for necessary small elementary and high schools.

7. Calculate district and charter revenue limit estimates. (Note: Charter School calculations have been disabled.)

8. Calculate infant entitlement estimates.

9. Reconcile existing database with database file supplied by CDE (Reconciliation mode).

10. Use state-supplied parameters or modified state parameters to aid in budgeting for future fiscal years (Forecasting mode).

11.2.1 School District Revenue Limit Entry Screens

Table 21 displays each school district revenue limit entry screen available to COEs and school districts, the type of data that needs to be entered, the periods the entry screen is available for entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	District Revenue Limit Adjustments
	ADA Adjustments, Revenue Limit Adjustments, Expenditures, and Community Day School waiver data for the school district.
	(
	(
	(
	(
	(
	

	Necessary Small School Certification Selection
	Select and certify schools for possible participation in the Necessary Small School funding program.
	(
	(
	(
	(
	(
	(

	Necessary Small School Funding Selection
	Select a school to be funded through the Necessary Small School Funding formula.
	(
	(
	(
	(
	(
	(

	Regional Occupational Centers and Programs (ROC/P)
	Allocated average daily attendance for a school district’s Regional Occupational Center/Program
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(

	Small Regional Occupational Centers and Programs (ROC/P)
	Allocated average daily attendance for a Small High School’s Regional Occupational Center/Program
NOTE: Not collected due to changes made by Education Code Section 42605.
	(
	(
	(
	(
	(
	(


Table 21: School District Revenue Limit Entry Screens

11.3 Charter School Procedures

Each charter school has specific procedures that should be followed to accurately report attendance data in time for each Principal Apportionment period. Charter schools can also estimate their revenue limits. (Note: Charter School calculations have been disabled.)

To report the charter school attendance data:

1. Install the Revenue software.

2. Add a charter school user and login.

3. Select the correct reporting period.

4. Enter charter school attendance data in each appropriate entry screen.

5. Ensure that the data have no errors by using the Check/Save utility in the appropriate entry screens.

6. Export the data for the charter school to a certified data file and send the file to your school district or COE.

7. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Printing blank reports, blank certifications, summaries, or certification exceptions.

3. Calculate charter revenue limit estimates. (Note: Charter School calculations have been disabled.)
4. Reconcile existing database with database file supplied by CDE (Reconciliation mode).

5. Use state-supplied parameters or modified state parameters to aid in budgeting for future fiscal years (Forecasting mode).

SELPA Procedures

Each SELPA Administrative Unit (AU) and LEA has specific procedures that should be followed to accurately report Infant Funding, and Extraordinary Cost Pool Claim (Annual only), data for each Principal Apportionment period.

To report the Infant Funding, and Extraordinary Cost Pool Claim data for SELPA AUs and LEAs:

1. Install the Revenue software.

2. Add a SELPA user and login.

3. Select the correct reporting period.

4. Enter SELPA Administrative Unit and LEA data in each appropriate entry screen.

5. Ensure that the data have no errors using the Check/Save utility in the appropriate entry screens.

6. Export the data to a certified data file.

7. Send the certified data file to your COE via e-mail, FTP, or on a floppy disk through the postal service.

8. Print and sign the certification page and send it to your COE.

Optional tasks include:

1. Printing reports for each entry screen.

2. Print AB 602 and infant entitlement reports.

3. Exporting data to an ASCII file for use in other software.

4. Printing blank reports, blank certifications, summaries, or certification exceptions.

5. Calculate AB 602 and infant entitlement estimates.

6. Reconcile existing database with database file supplied by CDE (Reconciliation mode).

7. Use state-supplied parameters or modified state parameters to aid in budgeting for future fiscal years (Forecasting mode).

11.3.1 SELPA Entry Screens

Table 22 displays each SELPA entry screen available to users from the county office, school district, and SELPA user groups, the type of data that needs to be entered, the periods the entry screen is available for entry, and whether the entry screen allows for multiple records.

	Entry Screen Name
	Data to be Entered
	Period Available
	Corrected
	Multiple Records

	
	
	P-1
	P-2
	Annual
	P-2
	Annual
	

	Infant Funding
	Total Infant units operated by the SELPA for the selected period. For Designated Instruction and Services Full-Time Equivalent Employees, of the number of DIS units entered as Operated SELPA-wide, enter the conversion of those units into Classified and Certificated employees.
	(
	(
	(
	
	(
	(

	Extraordinary Cost Pool Claim
	Extraordinary cost pool claim data.
	
	
	(
	
	(
	(


Table 22: SELPA Entry Screens

11.4 Calculations

Users from the county office, school district, charter school, and SELPA user groups can use the Revenue software to perform calculations based on saved data. The calculation options are displayed under the Tools menu. (For more information on using the Tools menu, please refer to Section 3.5.2.4).

After all data is inputted or imported from all LEAs, revenue limit estimate calculations can be run. To do so, select the appropriate calculation from the Tools menu, select the Revenue Limit calculation type from the drop-down list (if applicable), and select Start.

Upon completion of processing, all calculations may be viewed and reports printed by selecting the appropriate revenue limit report type from the File>Print menu. For more information on printing revenue limit reports, please refer to Section 8.2.1.

Table 23 displays the types of calculations each user group can perform.

	User Group
	Available Calculations

	
	

	County Office
	· County and Districts 
· AB 602 Estimate

· Out of Home Care Estimate

· Infant Entitlement

· Extraordinary Cost Pool (Annual only)

	School District
	· District Revenue Limits

· Infant Entitlement

	Charter Schools
	· Charter Revenue Limit (Note: Charter School calculations have been disabled.)

	SELPA
	· AB 602

· Infant Entitlement


Table 23: Revenue Software Calculations

For more information on calculations, please refer to the Principal Apportionment Revenue Software Help File.

Revenue Software Modes

The Principal Apportionment Revenue software has three (3) modes of operation—Certification, Reconciliation, and Forecasting. The default mode for the software is Certification mode.

You can change the Revenue software’s mode of operation by using the Reconciliation and Forecasting options from the Tools menu. 

Note:
While in Certification mode, you can switch to Reconciliation or Forecasting mode. However, while in either Reconciliation or Forecasting modes, you can only switch back to Certification mode.

To switch from Certification mode to Forecasting mode, select Forecasting from the Tools menu, and then select a fiscal year from the sub-menu. The Revenue software logs you out. When you log back in, the application is in Forecasting mode. While in Forecasting mode, if you select the Tools menu, then the Forecasting sub-menu, a checkmark displays next to the forecasted year. Select the forecasted year to exit Forecasting mode. You are logged out, and when you log back in, the application returns to Certification mode.

To switch from Certification mode to Reconciliation mode, select Reconciliation from the Tools menu. A dialog box prompts you to select the reconciled file you want to use.

Note:
To use the Revenue software’s Reconciliation mode, a reconciled database file must exist in the Revenue software’s Data folder where the Revenue software was installed.

After selecting the reconciled file, the Revenue software logs you out. When you log back in, the application is in Reconciliation mode. When in Reconciliation mode, a checkmark displays next to Reconciliation in the Tools menu. Select Reconciliation from the Tools menu to exit Reconciliation mode. You are logged out, and when you log back in, the application returns to Certification mode.

For specific information on how to use the Reconciliation and Forecasting modes, please refer to the Revenue Software Help File.

Forecasting Mode

In Forecasting mode, you can enter testing values to aid in budgeting for the following programs:

	Local Education Agency
	Available Forecasting Programs

	County Office of Education
	County Office Attendance

School District Attendance

Charter School Attendance

County Office Revenue Limits

School District Revenue Limits

Taxes

SELPA

	School District
	School District Attendance

Charter School Attendance

School District Revenue Limits 

SELPA

	Charter School
	Charter School Attendance

	SELPA
	SELPA


A forecasted database from the previous year must exist to forecast future fiscal year databases. For example, you cannot forecast for the 2010-11 fiscal year if the forecasted database for 2009-10 does not exist. When attempting to forecast a fiscal year when the previous year’s forecasted database does not exist, the Revenue software logs you out. When you log back on to the software in this case, it reverts to Certification mode.

When forecasting data, the Revenue software duplicates the existing database and allows LEAs to change data and perform revenue limit calculations for future fiscal years. You can also change state parameters, preload data, and SELPA parameters while in Forecasting mode.

Note:
While in Forecasting mode, the following functions are disabled: Import, Export, Upload Certified Data, Reconciliation, Printing Certifications, Printing Blank Reports, and viewing the LEA Status reports.

Reconciliation Mode

In Reconciliation mode, you can adjust your database with the certified Principal Apportionment data calculated by the CDE at the end of each period. You can either import and view the reconciled database without changing your existing data, or import the reconciled database and overwrite the existing data.

Note:
While in Reconciliation mode, the following functions are disabled: Import/Export, Upload Certified Data, Forecasting, Printing Certifications, Printing Blank Reports, and viewing the LEA Status reports.

Prepared Nov. 24, 2009
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